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An emissions inventory is a critical element in the control of air pollution and the 
attainment of national and state ambient air quality standards. It is also an 
essential tool in developing regulations and control strategies to fulfill the 
California Air Resources Board’s (CARB) mission to promote and protect public 
health, welfare, and ecological resources through the effective and efficient 
reduction 
n of air pollutants while recognizing and considering the effects on the economy 
of the state. 

 
An emissions inventory (for any source category) can be calculated, at the most 
basic level as the product of an emission rate, expressed in grams of a pollutant 
emitted per some unit of source activity, and a measure of that source’s activity. 
The following expression illustrates this basic relationship between the emissions 
rate and source activity used to calculate emissions: 

Emission Factor X Source Activity = Emissions 
 

For on-road motor vehicles, emissions rates are typically expressed as mass of 
pollutant emitted per mile driven, per vehicle per day, or per trip made, 
depending on the emissions process being analyzed. An emissions process for a 
motor vehicle is the physical mechanism that results in the emissions of a 
pollutant (e.g., the combustion of fuel, the evaporation of fuel, tire or brake wear, 
or the start of an engine). 

 
The California Air Resources Board (CARB) developed an EMission FACtors 
(EMFAC) model to calculate statewide or regional emissions inventories by 
multiplying emissions rates with vehicle activity data from all motor vehicles, 
including passenger cars to heavy-duty trucks, operating on highways, freeways, 
and local roads in California. 

1.1 THE MOTOR VEHICLE EMISSIONS INVENTORY 
1 INTRODUCTION 
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1.2 EMFAC2017  
Over the years, tougher emissions standards have been met with technological 
solutions of increasing complexity. As a result, the emissions estimation models 
have also grown in size and complexity. 

 
EMFAC2017 is the latest emissions inventory model that calculates emissions 
inventories for motor vehicles operating on roads in California. EMFAC2017 
represents the next step forward in the ongoing improvement process for EMFAC, 
and reflects the CARB’s current understanding of how vehicles travel and how 
much they pollute.  The EMFAC2017 model is needed to support the Air 
Resources Board’s regulatory and air quality planning efforts and to meet the 
Federal Highway Administration’s transportation planning requirements. 

 
The EMFAC2017 model can be used to show how California motor vehicle 
emissions have changed over time and are projected to change in the future. This 
information helps CARB evaluate prospective control programs and determine 
the most effective, science-based proposals for protecting the environment. 
EMFAC2017 includes the latest data on California’s car and truck fleets and travel 
activity. New forecasting methods have been incorporated for developing vehicle 
age distributions and estimating vehicle miles traveled. The model also reflects 
the emissions benefits of Federal and California recent rulemakings such as 
Federal Phase 2 Greenhouse Gas Standards. The model also includes updates to 
truck emission factors based on the latest test data. More details about the 
updates in emissions calculation methodologies and data are available in the 
EMFAC2017 Technical Support Document. 

 
For EMFAC2014, CARB staff has departed from using Fortran (the legacy 
programming tool that was used for previous versions of EMFAC) and has rebuilt 
the model using Python and MySQL software. EMFAC2017 will use a similar 
framework as EMFAC2014. The use of a Python and MySQL based framework 
was done for several reasons: 

• To make the model more user friendly; 
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• To make it easier to update the model code and associated data & 
methodologies into the future; 

• To provide greater flexibility for incorporating and assessing future 
new rules; 

• To provide the capability for developing more detailed emissions 
inventories; 

• To make it easier to transfer EMFAC output to other tools. 
 

Figure 1.1 displays a flow chart indicating the GUI selections necessary to 
generate the various outputs of EMFAC2017. The Emissions Mode can be used to 
estimate tons of emissions per day and the Emission Rate Mode, which can be 
used to estimate grams of emission per unit of activity, has been disabled. 

Figure 1-1. EMFAC2017 Overall Flow 
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IMPORTANT! – “Custom Activity” Mode 

The EMFAC2017 Custom Activity Mode (discussed in detail in Chapter 5.2) can be used to 
produce emissions inventories for two specific types of assessments: conformity assessments 
and SB375 assessments. 

For conformity assessments, emissions are estimated with all current controls active, except 
Low Carbon Fuel Standards (LCFS). The reason for excluding LCFS is that most of the 
emissions benefits due to the LCFS come from the production cycle (upstream emissions) of 
the fuel rather than the combustion cycle (tailpipe). As a result, LCFS is assumed to not have a 
significant impact on CO2 emissions from EMFAC’s tailpipe emission estimates. 

For SB375 assessments, the Advanced Clean Cars (ACC)/Pavley rules are deactivated. 
Because the ACC regulation has certain assumptions about vehicle usage built into it, default 
data in custom activity templates produced for conformity assessments will not match the 
default data in templates for SB375 assessments. For the same reason, estimates of CO2 will 
also differ. 

 

IMPORTANT! – “GHG Emissions” 
 

The EMFAC2017 model provides additional capability to come up with GHG emission 
estimates. A GHG module consistent with CARB’s official methodology is developed and 
included in the EMFAC2017. The GHG module can generate emissions of the following three 
climate pollutants: CO2, CH4, and N2O, as well as their CO2 equivalents (CO2e) based on 
GWP values from IPCC’s Fourth Assessment Report (AR4). 
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1.3 ABOUT THIS DOCUMENT  
The purpose of this EMFAC2017 User’s Guide is to familiarize users with the 
features and controls in the EMFAC2017 model. More information regarding the 
methodologies used in EMFAC2017 to estimate emissions and emission rates will 
be made available in the EMFAC2017 Technical Documentation to be released 
with the final version. 
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2 POLLUTANTS AND PROCESSES MODELED  
This section describes the pollutants and emissions processes currently modeled 
in EMFAC2017. 

2.1 POLLUTANTS  
The model calculates emissions factors and emissions inventories for the 
following primary pollutants: 

• Carbon monoxide (CO) 
• Nitrogen oxides (NOx) 
• Hydrocarbons (HC): HC can be expressed as TOG (total organic gases), 

ROG (reactive organic gases), THC (total hydrocarbon), or CH4 
(methane). The THC class includes compounds with H and C atoms only, 
carbonyls and halogens are not included in the class. The TOG class 
includes all organic gases emitted into the atmosphere. The ROG class is 
same as EPA’s VOC (volatile organic compounds) definition and does not 
contain compounds exempt from regulation. 

• Particulate matter (PM): PM estimates are provided for total suspended 
particulates for particulate matters 10 microns or less in diameter 
(PM10), and particulate matters 2.5 microns or less in diameter (PM2.5). 

• Sulfur oxides (SOx): Emissions of oxides of sulfur are a function of the 
sulfur content of fuel. The model calculates these emissions by 
multiplying the fuel consumption by the weight fraction of sulfur in a 
gallon of fuel. 

• Fuel: Although, fuel is not a pollutant, fuel consumption is calculated 
based on the tailpipe emissions of CO, CO2 and THC using the carbon 
balance equation. 

• Greenhouse Gases (GHG): GHG emissions are consisted of complete 
combustion CO2, Nitrous Oxide (N2O) and Methane (CH4). These are 
the greenhouse gases that are now included in the EMFAC2017 but not 
in EMFAC2014 or prior versions. 
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2.2 EMISSIONS PROCESSES  
Emissions (especially HC) emanate from a vehicle during all hours of the day. The 
magnitude of these emissions varies with what is happening with the vehicle, 
such as running on the road, idling at a loading zone, sitting outside in the sun, or 
just starting. Emissions processes account for all emissions of a vehicle across all 
hours of the day, regardless of whether the vehicle is in motion or whether or not 
it has been started. The types of emissions processes in the model are: 

• Running Exhaust Emissions (RUNEX) that come out of the vehicle 
tailpipe while traveling on the road. 

• Idle Exhaust Emissions (IDLEX) that come out of the vehicle tailpipe 
while it is operating but not traveling any significant distance. This 
process captures emissions from heavy-duty vehicles that idle for 
extended periods of time while loading or unloading goods. Idle exhaust 
is calculated only for heavy-duty trucks. 

• Start Exhaust Tailpipe Emissions (STREX) that occur when starting a 
vehicle. These emissions are independent of running exhaust emissions 
and represent the emissions occurring during the initial time period 
when a vehicle’s emissions after treatment system is warming up. The 
magnitude of these emissions is dependent on how long the vehicle has 
been sitting prior to starting. Please note that STREX is defined 
differently for heavy duty diesel trucks than for other vehicles. More 
details can be found in the EMFAC2017 Technical Support Document. 

• Diurnal Evaporative HC Emissions (DIURN) that occur when rising 
ambient temperatures cause fuel evaporation from vehicles sitting 
throughout the day. These losses are from leaks in the fuel system, fuel 
hoses, connectors, as a result of the breakthrough of vapors from the 
carbon canister. If a vehicle is sitting for a period of time, emissions 
from the first 35 minutes are considered as hot soak and emissions from 
the remaining period are considered as diurnal emissions, provided that 
the ambient temperature is increasing during the remaining period of 
time. 
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• Resting Evaporative Losses (RESTLOSS) that occur while the vehicle is 
sitting are caused by fuel permeation through rubber and plastic 
components. Emissions are counted as resting loss emissions if the 
vehicle has not been operated for 35 minutes and has been stationary, 
while the ambient temperature is either constant or decreasing. 

• Hot Soak Evaporative HC Emissions (HOTSOAK) that occur immediately 
after a trip are due to fuel heating as an engine remains hot for up to 35 
minutes after being switched off. In older, carbureted vehicles these 
emissions are attributed to vapor losses from the carburetor float bowl. 
In newer, fuel-injected vehicles, these vapor losses come from leaky fuel 
injectors or from fuel hoses. 

• Running Loss Evaporative HC Emissions (RUNLOSS) that occur are a 
result of hot fuel vapors escape from the fuel system or overwhelm the 
carbon canister while the vehicle is operating. 

• Tire Wear Particulate Matter Emissions (PMTW) that originate from tires 
as a result of wear. 

• Brake Wear Particulate Matter Emissions (PMBW) that originate from 
brake usage. 



EMFAC2017 User’s Guide, v1.0.2 

13 

 

 

 

3 INSTALLATION AND CONFIGURATION OF EMFAC2017 
3.1 SYSTEM REQUIREMENTS 

• Operating System: Microsoft Windows 
• At least 2 GB of free space is required to install EMFAC2017. 
• The space needed to run EMFAC2017 depends on the level of detail in 

the output, the number of sub-areas and calendar years selected, and 
the number of runs. At least 50 GB free space is recommended. 

• The model was tested on the following system 
• Processor: Intel® Core™ 2 Duo CPU E8400 @3.00GHZ 
• Installed memory (RAM): 4.00 GB (3.90 GB Usable) 
• System type: 64-bit Operating System 
• Windows Edition: Windows 7 Enterprise 
• The model will run faster with a faster CPU and more RAM. 

We do not recommend installing EMFAC2017 on a system that already has the 
USEPA’s MOVES model installed on it. Having both models installed on one 
system could potentially lead to issues in the configuration of MySQL causing 
problems when importing the default database. We recommend EMFAC2017 to 
be installed on a “clean” machine to avoid these problems. Note that installing 
EMFAC2017 on a system with EMFAC2014 installed should be fine and should not 
create any conflicts between the two. 

3.2 PRE-INSTALLATION NOTES  
• MySQL Community Server 5.x or higher must be installed on your local 

computer prior to installing EMFAC2017. The software can be 
downloaded from http://www.mysql.com/downloads/mysql/ and can 
be installed following the installation instructions at 
http://dev.mysql.com/doc/refman/5.6/en/mysql-installer-gui.html 

• Only the MySQL server is required for EMFAC2017 to run. If the users do 
not need any other functions, they can simply choose the “Server only” 
setup type when installing MySQL. Users should NEVER choose “Client 
only” setup type for a fresh new installation. 

http://www.mysql.com/downloads/mysql/
http://dev.mysql.com/doc/refman/5.6/en/mysql-installer-gui.html
http://dev.mysql.com/doc/refman/5.6/en/mysql-installer-gui.html
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• If the users need other functions, they can choose from “Developer 
Default”, “Full” or “Custom”, and make sure the “MySQL Server” 
component is in the list if they choose “Custom”. 

• Make sure to write down the password for the “root” account. 
• The model has been tested on MySQL 5.5 and 5.6. Other versions of 

MySQL may also work but have not been tested. 
• If MySQL is already installed, the existing MySQL may work, as 

long as it was installed through the full installation. You will still 
need to remember and input the password for the root account. 

• If MySQL needs to be reinstalled, the existing version should be 
uninstalled first. 

• EMFAC2017 was developed using Python version 2.7 and MySQL 
Community Server (5.6). Python was used to develop the program, and 
MySQL is used to manage the data. Python is not required on the user’s 
computer to run the model. 

• Please note that this User’s Guide assumes the default directory for the 
model is “C:\emfac2017\”. The model should also work in a directory 
other than this default. 

 
 
Note! 

Please do not make any changes to the EMFAC default 
database on the MySQL server. The model may fail or 
generate erroneous results if changes are made to the 
database. 
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3.3 MODEL INSTALLATION  
1. Extract the EMFAC2017 package to a folder of your choice on your local 

drive. This user’s guide assumes the package is extracted or copied to 
the C: root directory. 

2. Right click on “emfac.exe”, in the installation directory 
("C:\emfac2017\emfac2017.exe") to create a shortcut or pin it to the 
taskbar or the start menu. 

3.4 MODEL CONFIGURATION  
1. Double click “emfac2017.exe” within the installation directory, or click 

the icon on the taskbar or start menu, to start EMFAC2017. The program 
will display a page that asks users to configure MySQL settings first using 
the MySQL Configurator. You may safely ignore any Microsoft Windows 
security or antivirus warning related to the EMFAC2017 software 
package. 

2. Click the “Launch MySQL Configurator” button to bring up the pop-up 
window shown below. This configuration is needed for installation of an 
updated model or when the configuration of MySQL is changed. 
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3. Keep “Host,” “Port,” and “Username” unchanged, and the “Password” 
will be the one you supplied upon installation of MySQL for the root 
account. 

4. Click “Test” to test the configuration. 
5. Click “Save” only when both the connection and directory are set 

correctly. Repeat the configuration steps if any mistake is made. 
 

 

6. EMFAC2017 will close and will need to be restarted. 
7. Restart the model and on the following screen click “Import EMFAC 

Default Database”. 
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8. After the import is completed, close the program and reopen it. 

• Please note that a user can reconfigure a previously configured 
EMFAC2017/MySQL connection by launching the MySQL Configurator 
from the Tools menu. This functionality could be used, for instance, to 
connect the model to a different MySQL server. 
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4 GETTING STARTED WITH EMFAC2017 
4.1 GENERAL TIPS 

• The EMFAC2017 console shows the status of the model and error 
messages, if any. 

• Consecutive items can be selected by shift-clicking and non-consecutive 
items can be selected by control-clicking in the list boxes. 

• The unit for fuel in the EMFAC2017 output is 1000 gallons/day and the 
unit for all other pollutants in the emissions inventory is tons/day. The 
fuel unit for natural gas vehicles are in diesel equivalent gallon (DEG). 

• The units for the output of the GHG module are detailed as follows. 
Column “emission”: in tons/day (and in thousand gallons/day where the 
"pollutant" is Fuel). Column “emission_annualized”: in tons/year (and in 
thousand gallons/year where the "pollutant" is Fuel). Column “CO2e”: in 
tons/day. Basically, it is to be consistent with the EMFAC model's 
historical convention; i.e., all emissions are in short tons and fuel 
consumption is in thousand gallons. There is only one column which is 
special with the GHG module, i.e., column “CO2e_annualized” in metric 
tons per year. This is to easily compare with considerable existing 
literature which reports CO2e using metric tons or even million metric 
tons such as those in Scoping Plan. Note that 1 ton = 0.907185 metric 
tons. 

• In order to manage the size of the output files, emissions and emission 
rates equal to zero are not indicated in the output files. Therefore, in 
instances when data are missing in the output file, the user can assume 
zero emissions or an emission rate of zero. The program is best viewed 
with "Smaller" text size on Windows. The “Smaller” text size is used by 
most people, and can be set within the Control Panel\Appearance and 
Personalization\Display 

• When canceling a run the program will try to terminate all the active 
queries, some may not stop immediately. But pressing the cancel will 
not remove the main GUI and the console. It only removes the running 
dialogue. 
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• Use the method described in Appendix 1 to estimate the disk space 
needed before starting a run to make sure there is enough free disk 
space to finish the run. 

 

 

4.2 GRAPHICAL  USER INTERFACE  
 

MENUS 
There are four menus in the parent, Home Screen window of EMFAC2017: “File”, 
“Run”, “Tools” and “Help”. 

Note! 
1. Do not close the console while the model is running. 
2. Limit the number of areas and calendar years and level of 

details selected for one run to manage the run-time of the 
current run and the size of the output. 

3. Splitting big runs into small runs is strongly recommended. 
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• The File Menu has four actions: “New” (new run), “Open” (open a saved 
run specification), “Save” (save a run specification), and “Exit.” Upon 
starting the program, the program automatically assumes the user is 
creating a new run and thus the parent window displays the Home 
Screen. One may choose to open a previous run by selecting “Open” in 
the File Menu and then selecting the appropriate file. 

• The Exit action of the File Menu will only work in EMFAC2017 if a 
calculation is not being made. If calculations are occurring, cancel the 
run first, and then exit. 

• The Run Menu has one action: “Run EMFAC.” 
• The Tools Menu has one action: “MySQL Configurator.” 
• The Help Menu has an “About…” action that will tell the user which 

version of the model is running. 
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HOME SCREEN, RUN MODES AND TYPES 
• The Home Screen (below) is automatically displayed after the model 

starts or when “New” is selected from the File Menu. 
 

 
• “Run Mode” and “Run Type” are the selection options in this “New” tab. 

There are two different Run Modes: “Emissions” and “Emission Rates.” 
• Under the “Emissions” run mode, two Run Types are available. “Default 

Activity” runs use default EMFAC activity data, while the “Custom 
Activity” run type allows the users to use their own activity data to run 
the model. The “Custom Activity” run type was formerly known as “SG” 
or “Scenario Generator”. It can be used to generate an input activity 
data file template or to load custom activity data to produce an 
emissions inventory for transportation planning, a SB375 report, etc. 
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5 GENERATING EMISSIONS INVENTORIES  
For regional analyses (as opposed to project-level analyses), there are two 
different modes in EMFAC2017 dictated by the travel activity data that are used. 

 
Default Activity Mode. EMFAC 2017 uses historical fuel sales to estimate vehicle 
miles traveled (VMT) as its default activity to facilitate fuel-based inventory 
analyses. 

 
Custom Activity Mode. It is necessary to use the latest regional motor vehicle 
travel activity data developed by local planning agencies to generate the regional 
on-road emissions for State Implementation Plans (SIPs). Thus, for SIP criteria 
pollutant (planning inventory) analyses, EMFAC2017 has the ability to allow the 
user to replace the fuel-based default data with user-supplied data from 
metropolitan and regional planning agencies. 
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5.1 USING DEFAULT ACTIVITY MODE  
In this section we explain how to accomplish a Default Activity Emissions run, 
which is typically performed for fuel-based emissions inventory analyses, either 
from the Home Screen or by loading an EMFAC2017 “.ers” file, saved from a 
previous run. The run parameters for a default emissions run are summarized in 
Appendix 2. 

 

STARTING A DEFAULT ACTIVITY RUN 
1. Go to the Home Screen by either restarting the model or clicking “New” 

in the File Menu. 
2. Pick “Emissions” and “Default Activity” and click “Start”. 

a. This takes the user to a window with four tabs (next page); the Area 
Tab, the Time Tab, the Vehicles Tab, and the Output Tab. 

b. Each tab presents options for the user to customize for the model run 
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AREA TAB 
• The Area Tab’s list boxes allow the user to choose different area types 

and areas for analysis (note the “Area” tab is highlighted below). The 
user may pick from one of six area types: Statewide, Air Basin, Air 
District, MPO, County, or Sub-Area. Please refer to Appendix 3 for area 
definitions. 
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• The user may pick only one Area Type, but has the option of selecting 
multiple Areas within the chosen Area Type by holding the Ctrl key while 
clicking on an area. 
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• “Air Basin” has been selected in the following window, so multiple 
selections can be made (see figure). 
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TIME TAB 
• In the “Time” tab, a single Calendar Year or multiple years may be 

selected; however, only one Season or Month may be selected for each 
run. 
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VEHICLES TAB 
• In the Vehicle Class list box, the user can select the vehicle classes of 

interest. All vehicles can be selected by clicking “Select All”. Both the 
EMFAC2007 and the EMFAC2011 Vehicle Classes are available. Please 
refer to Appendix 4 for definitions of vehicle categories. 

• The data can be output in either “By Model Year” or “Aggregated” form. 
• Choosing “By Model Year” and selecting a large number of Model 

Years will increase the size of the output considerably. 
• The user can choose to output the data “By Speed” (for output at each 

speed) or “Aggregated” (for combined output only). 
• Choosing “By Speed” will increase the size of the Output Table 

considerably. 
• The user can also choose to have “Output for Natural Gas Heavy Duty 

Vehicles” 
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• If “Yes” is chosen in the “Output for Natural Gas Heavy Duty 
Vehicles” form, the user can generate emissions and activity 
outputs for natural gas heavy duty vehicles other than Urban 
Transit Buses (UBUS) and Solid Waste Collection Vehicles (T7 
SWCV). 

• This is an experimental feature. Please refer to the technical 
documentation for further information. 

 
 

OUTPUT TAB 
 
 

 
 

• The “Pollutants” group box allows the user to choose the Pollutants for 
which data are to be included in the output. One new option in the 
“Pollutants” group box is “GHG and Fuel” which, once selected, will 
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generate the GHG module’s output. The GHG module’s output normally 
includes CO2, CH4, N2O and fuel consumption. 

• The “Activities” group box indicates which Activity data can be selected 
to be included in the output. 

• The “Options” group box allows the user to choose “Output by Process” 
to output data per emissions process (e.g., Running Exhaust Emissions, 
or Start Exhaust Tailpipe emissions) or to choose “Output by Cat- 
NonCat” for output per Catalyst-Equipped and Non-Catalyst Equipped 
groupings. 

• The “Save Data” group box selection will indicate whether the output 
data from the current run will be saved by the model INTERNALLY for 
reuse by eligible future runs. This does not affect model outputs. 

• The “Output Options” group box allows users to: 1) split the model 
output into separate files based upon Sub-Area and Calendar Year to 
keep the size of the output files manageable; 2) specify a different 
directory to hold the output files other than the default directory at 
“C:\emfac2017\Output” by clicking the “Change Directory” button. 

• The standard output format for a Default run is “CSV” (comma- 
separated text files). The format is different than the CSV report output 
in previous versions of EMFAC. The output files will have a numerical 
timestamp in the name of the files. 
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STARTING THE MODEL RUN 
1. Limiting the number of calendar years, areas, and the level of detail 

selected will reduce the free space required for a run. This requirement 
decreases considerably if you deselect some of the options such as “By 
Hour”, “By Model Year”, etc. 

2. Click “Run EMFAC”, in the Run Menu, or the “Run” button at the lower 
right corner of the Output tab to start the model run. 

 

SAVING THE RUN SPECIFICATION 
• Save the “Run Specification” (as “.ers” files) for future use after all the 

run parameters have been determined. Click “Save” in the file menu or 
click “OK” in the pop-up window after the run button is clicked to save 
the .ers file. 
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ONCE THE RUN HAS STARTED 
• The time it takes to finish a run depends on how many sub-areas and 

calendar years were selected, the aggregation level specified for the 
output files, and the performance of the computer. 

• The model run can be stopped by clicking “Cancel” in the EMFAC2017 
Window. 

• The status window can be minimized by minimizing the main window. 
 

 

• The following window provides the names and locations of the output 
files generated after the run has finished. 

• A default emissions run file name will consist of the sub-area, the 
analysis year, the season, data type (emission, GHG, VMT, vehicle 
population, and trips), and the time when the output file was generated. 
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The user has the option to modify the first half of the filenames to their 
own naming standards when saving the run specification. However, the 
data type and output file generation time will still be indicated at the 
end of filename. 
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START DEFAULT RUN USING A SAVED .ERS FILE 
1. Click “Open” in the File Menu to load the file. 

 
 

 
2. The run parameters will be loaded to the model and can be modified 

and saved as a new .ers file by clicking “Save” in the File Menu. 
 

SAVE OUTPUT DATA FROM A RUN FOR FUTURE USE 
As a way to reduce computational time, the model allows the output data from 
the current run to be saved for future use if “Save data from this run for future 
use” is selected in the output tab. This works for both Default Activity Runs as 
well as Custom Activity (SG) runs. 
Data saved from previous runs can be used if one or more of the three criteria are 
met: 

1. The current run has exactly the same run parameters as one of the 
previous runs that have output saved. 

2. The run parameters (Calendar Years, Areas) of the current run are a 
subset of parameters of one of the previous runs that have output 
saved. 

3. The current run has fewer details or is more aggregated than the 
previous runs with saved output. 
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Model run time is significantly reduced when the saved output from 
previous runs option is used for the current run. Extracting data already 
stored in the model database is much faster than recalculating it. 
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5.2 USING CUSTOM ACTIVITY MODE  (SG)  
BACKGROUND 

The Custom Activity Mode of EMFAC2017 is designed to perform emissions 
assessments for determining conformity with the state implementation plan and 
for compliance with SB375 targets. Both types of assessments are most often 
done by various planning agencies and air districts throughout California. These 
assessments require the user to create custom activity data files containing 
vehicle miles travelled (VMT) and/or speed profile data. This customized activity 
data will then be used for scaling the default vehicle emissions produced by 
EMFAC2017. Prior to EMFAC2014, this function was performed by EMFAC2011- 
SG (“Scenario Generator”) or the What If Scenarios (WIS) generator in EMAC2007 
and older versions. 

 

TYPES OF CUSTOM ACTIVITY DATA 
There are two custom activity input formats supported by EMFAC2017 known as 
standard format: 

 
• templates generated by EMFAC2014 
• templates generated by EMFAC2017 

 
For all types of SG templates, the names of the worksheets MUST be exactly as 
produced from either EMFAC2014, or EMFAC2017. EMFAC2017 uses these 
worksheet names to identify what type of data is present; so, worksheets with 
any other names will be ignored. The user must provide either daily total VMT or 
daily total VMT by vehicle-tech. Speed fraction profiles are optional 
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EMFAC2017 can import multiple sets of activity data at one time. Also, 
EMFAC2017 can only process data for multiple scenarios with the same type of 
area and season. Files with different area types or seasons or SB375 settings 
cannot be loaded together. That is, one cannot run a scenario with the SCAG MPO 
and the Lake Tahoe Air Basin, since the first is an MPO and the second is an Air 
Basin. Also files with same area/calendar year combinations will be over-written. 
For example, loading two different template files for Alameda/CY2030 with 
different VMTs at the same time will only generate one emissions output (VMT 
data from the latter file will be used for emissions calculations) 

 
Standard Format: 
This section will cover how to generate a custom activity file in EMFAC2017 in 
more detail. Generally speaking, EMFAC2017 same as EMFAC2014 will produce a 
template with the default VMT and the optional hourly speed fraction profile 
data. The EMFAC2017 custom activity data format is always saved in the Excel 
and suffix is “*.xlsx”. The Standard custom activity data format is similar to that 
of EMFAC2011-SG, except the scenario number and title columns are removed. 
The table below summarizes the worksheets contained in the EMFAC2017- 
formatted Excel activity template file (repeated from the table provided earlier in 
this section). 

Worksheets in EMFAC2017 Format Activity Templates 

*Optional – may or may not be created based on user input; **One, not both, will exist. 
 

Template File 
Format Type Worksheet Name Description of Worksheet Data Fields 

 
EMFAC2017 

And 
EMFAC2014 

(*.xlsx) 

settings Season/month and whether it is a SB375 template 
daily_total_vmt** Daily total VMT 

daily_vmt_by_veh_tech** Daily VMT by vehicle type and fuel 
 

hourly_fraction_veh_tech_speed* Hourly speed profile calculated using default VMT by 
hour by speed 
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The settings worksheet is used for two purposes: to specify the season/month 
value for the desired emissions run, and to indicate whether or not the template 
is for SB375 or conformity purposes. 

 
The table below summarizes the effect of selected GUI options in EMFAC2017 on 
which worksheets are generated (see ** in previous table) and how custom 
activity scaling is performed. 

 
EMFAC2017 Templates: Effect of GUI Options on Worksheets and Scaling 

User-Select GUI Options Scaling Approach 
(Cannot be Modified) 

 
VMT Data Type 

Custom 
Hourly Speed 

Fractions 

 
VMT Scaling Result 

 
Speed Scaling? 

Total Daily VMT Unchecked Scaling by VMT Total No 
VMT by Vehicle and 

Fuel Type Unchecked Scaling by VMT-Veh Tech No 

Total Daily VMT Checked Scaling by VMT Total Yes 
VMT by Vehicle and 

Fuel Type Checked Scaling by VMT-Veh Tech Yes 

 
IMPORTANT! If the user opts to generate an SB375 template (more details 
provided in the next section), the Excel template will be ‘hard coded’ as an SB375 
template. This is because SB375 runs require the Pavley and Advanced Clean Cars 
standards to be turned off in the calculations made for the emissions inventory 
that will be generated. The Advanced Clean Cars program assumes a different 
fleet mix and vehicle miles travelled, so output produced for SB375 purposes will 
not match output that was not produced for SB375 purposes. 

 

GENERATING A CUSTOM ACTIVITY TEMPLATE 
The run parameters for generating a custom activity template are summarized in 
Appendix 5. 

1. Select the “Custom Activity (SG)” Run Type, and then “Generate Custom 
Activity Template” in the pop-up dialog box that appears. 
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2. Click “Start”. The following window will appear: 
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3. In the Area tab, you can change the area type by clicking where “Sub- 
Area” appears above. 

4. Select one or more Areas, however, the more areas selected, the longer 
the runtime will be. If you hold down either the shift or the control key 
while clicking, you can select multiple areas. 

5. Click “Next” or the Time tab. 
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6. On the Time tab, select one or more calendar years, however, the more 
years you select, the longer runtime will be. 

7. Select “Season” or “Month” and then specify which Season or Month 
you would like to use. 

 
 

 
8. Click “Next” or the VMT tab. 
9. On the VMT tab, select the VMT data type you would like for inputting 

the data into the template you will generate. 
10. Select “Custom Hourly Speed Fractions” if your own speed profile will be 

used. 
11. Choose whether or not the template will be for SB375. 
12. Click the “Generate Template” button. 
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IMPORTANT! If the user opts to generate an SB375 template (by checking the 
“SB375 Analysis” checkbox), the resulting Excel template will be ‘hard coded’ as 
an SB375 template (i.e. a user will not be able to manually modify the SB375 
status in the output Excel file). This is because SB375 runs require the Pavley and 
Advanced Clean Cars standards to be turned off in the calculations made for the 
emissions inventory that will be generated. The Advanced Clean Cars program 
assumes a different fleet mix and vehicle miles travelled, so output produced for 
SB375 purposes will not match output that was not produced for SB375 purposes. 
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13. Select where the template will be saved, then click “Save” and the 
model will start generating the template. 

 

 

 
14. Click “Save” and the model will start generating the template. 
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The following window will be shown after the template is generated. 
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MODIFYING CUSTOM ACTIVITY TEMPLATES 
Custom activity templates are generated in a Microsoft Excel format. Users can 
use Excel to edit the data to meet their needs. Before using the activity 
templates, there are several things to know: 

• Standard custom activity templates are in Microsoft Excel worksheet 
(.xlsx) format; while EMFAC2011-SG Templates have the suffix “xls”. 

• The worksheet names for either of these types of custom activity 
template must not be changed. These names are used to identify what 
type of data is present. Worksheets with any other names will be 
ignored. 

• The order and names of columns should not be changed on worksheets 
and data rows should not be deleted. 

• Standard custom activity Templates have a worksheet named “Settings” 
(below). This is primarily used to define the season or month being 
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analyzed and whether the custom activity template contains activity for 
a conformity assessment or a SB375 assessment. The field indicating 
the season/month can be changed; the field with the SB375 setting 
cannot be changed. 

 

 
• For worksheets broken out by vehicle-tech, all vehicle-tech types must 

be present. If you generate a standard custom activity template, all 
necessary vehicle-tech’s are provided. 

• Speed fractions should add up to one for each hour in the 
“Hourly_Fraction_Veh_Tech_Speed” tab. 
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• The EMFAC default speed profile will always be used for the following 
vehicle types for all regions: 

UBUS – Gas* 
UBUS – Dsl* 
PTO – Dsl 
T7 SWCV – Dsl 

• The EMFAC default speed profile will always be used for drayage trucks 
for Alameda (SF), Los Angeles (MD), Los Angeles (SC), San Bernardino 
(MD), and San Bernardino (SC): 

T7 Other Port - Dsl 
T7 POAK - Dsl 
T7 POLA - Dsl 

 

RUNNING EMFAC WITH A CUSTOM ACTIVITY TEMPLATE 
NOTE: The run parameters for generating a customized activity inventory are 
summarized in Appendix 6. 

1. Return to the Home Screen by selecting “File”, “New” from the menu 
and select “Custom Activity (SG)”. 

2. Select “Load Custom Activity File” and click the “Start” button. 
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3. SB375 will be automatically selected, if it is already specified as a SB375 
run, in the Standard custom activity template. 

 

 
4. Click the “Load Custom Activity” button and find the file. You can hold 

down either the shift or control keys during selection to load more than 
one file at a time. 

* IMPORTANT * 

Files with different area types or seasons or SB375 settings cannot 
be loaded together. Also files with same area/calendar year 
combinations will be over-written. For example, loading two different 
template files for Alameda/CY2030 with different VMTs at the same 
time will only generate one emissions output (VMT data from the 
latter file will be used for emissions calculations) 
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5. Select on the desired file and then click “Open”. Click “Ok”. 
 
 

 
 

 
6. Information about the loaded file is displayed on the window. Make 

sure the correct file has been selected. 
7. In the output tab, pick the Report Type, choose whether or not to save 

the output data for future use, and change the output location if 
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desired. (See Chapter 7 for a description of the Output Files generated 
by EMFAC2017). 
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8. An SB375 report will only be generated if it is specified to be a SB375 
run. 
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9. Click “Run” to start the calculation. 

 
10. After the run completes, a window will show the Output File location 

and file name. 
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6 GENERATING EMISSIONS RATES  
This section will describe the actions needed to generate emissions rates for a 
Project-Level Assessment or for projects using project specific data. Please note 
that similar to EMFAC2014, all emissions rates for project-level assessments can 
be obtained from a single source, the EMFAC2017 model. 

 

 
NOTE: The run parameters for generating emissions rates are summarized in 
Appendix 7 . 

1. Go to the Home Screen by either restarting the model or clicking “New” 
in the File Menu. 

2.  Pick Emission Rates and Project-Level Assessment (PL) as the Run Type 
and click “Start”. 
a. This takes the user to a window with four tabs; the Area Tab, the Time 

Tab, the Vehicles Tab, the Meteorology Tab, and the Output Tab. 
Each tab presents options for the user to customize the PL run. 

6.1 SETTING UP A PROJECT-LEVEL ASSESSMENT EMISSIONS 
RATES RUN 
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AREA TAB 
• The user may pick only one Area Type, but has the option of selecting 

multiple Areas from within the chosen Area Type. 
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TIME TAB 
• In the “Time” tab, a single Calendar Year or multiple years may be 

selected; however, only one Season or Month may be selected for each 
run. 

• Emissions rates vary by season or month as a result of variation in the 
Fuel Reid Vapor Pressures by month or season due to fuel composition 
differences. 
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VEHICLES TAB 
• The user can select the vehicle classes of interest. All vehicles can be 

selected by clicking “select all”. Emissions rates can also be provided at 
various sub-levels using the EMFAC2011 or EMFAC2007 vehicle 
groupings and selections such as truck/non-truck, or truck1/truck2/non- 
truck levels. Please refer to the definitions of vehicle categories in 
Appendix 4. 

• The data can be output in either the “By Model Year” or the 
“Aggregated” format. 

• The By Model Year option is for projects in which the activity 
data by model year are used. 

• The Aggregated option is for projects in which only the 
combined total activity, and not the activity by model year, is 
used. 

• The user can choose to output the data “By Fuel” (for output by each 
fuel type) or “Aggregated” (for combined output only). 

• In a PL Run, Speed bins must be selected. 



EMFAC2017 User’s Guide, v1.0.2 

58 

 

 

 

 



EMFAC2017 User’s Guide, v1.0.2 

59 

 

 

METEOROLOGY TAB 
• PL Runs require the input user-defined meteorology data 
• The data must be input in temperature (Fahrenheit) and relative 

humidity (percentage without % sign) pairs with one pair in each row. 
See the example in the following screen shot. 

• The number of pairs of temperature and relative humidity will be 
limited to 24 for each PL run; that is one pair for each hour of the 
day 

• The user may either type the temperatures and relative humidity 
pairs into the meteorology box or copy the data from an Excel 
File. 

• The allowed input temperature range is from -20°F to 120°F and the 
allowed input relative humidity range is from 0% to 100%. 

• These input ranges are broader than the corresponding default 
ranges, used in EMFAC2017. The default ranges are 16.7°F to 
106.9°F and 13%-100%; these are based upon real meteorology 
data 



EMFAC2017 User’s Guide, v1.0.2 

60 

 

 

 

 



EMFAC2017 User’s Guide, v1.0.2 

61 

 

 

OUTPUT TAB 
• The Pollutants group box allows the user to choose the Pollutants for 

which data are to be included in the output. 
 

 
• The Output Directory group box allows users to specify a different 

directory to hold the output files by clicking the “Change Directory” 
button. 

 

IMPORTANT – CO2 emission rates from PL tool are tailpipe CO2 and are 
not the same as the “complete combustion CO2” under the “emission” 
mode. 
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6.2 STARTING THE  PROJECT-LEVEL MODEL RUN  
• Click “Run EMFAC”, in the Run Menu, or the “Run” button at the lower 

right corner of the Output tab to start the model run. 
• Save the “Run Specification” (as .ers file) for future use after all run 

parameters have been determined. Click “Save” in the File Menu or 
click “OK” in the pop-up window after the run button is clicked to save 
the .ers file. 

 

 
 

• The model run can be stopped by clicking “Cancel” in the EMFAC2017 
Window. 

• The pop-up window provides the names and locations of the output files 
generated after the run has finished. 
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7 DESCRIPTION OF OUTPUT  
By default, the output files are saved in the “output” folder under the EMFAC 
installation directory. Users can specify another folder to hold these files. Output 
file names, which are generated automatically, start with the name of .ers files or 
the names of the custom activity input files, followed by output type and a 
timestamp suffix. 

 
For example, the default names for the output files for the default activity 
emissions run specification file “Default_AlamedaSF_2012_Annual.ers” will be: 

• “Default_AlamedaSF_2012_Annual_emission_20171230114553.csv” for 
the emissions inventory file; 

• “Default_AlamedaSF_2012_Annual_ghg_20171230114553.csv” for the 
ghg emissions inventory file; 

• “Default_AlamedaSF_2012_Annual_population_20171230114553.csv” 
for the vehicle population file; 

• “Default_AlamedaSF_2012_Annual_trips_20171230114553.csv” for the 
trips file; 

• “Default_AlamedaSF_2012_Annual_vmt_20171230114553.csv” for the 
vehicle miles traveled file. 

 
The default names for the output files for the custom activity emissions input file 
“Custom_KernSJV_2020_Annual.xlsx” will be: 

• “Custom_KernSJV_2020_Annual_emission_20171222143741.csv” for 
the emissions inventory file; 

• “Custom_KernSJV_2020_Annual_population_20171222143741.csv” for 
the vehicle population file; 

• “Custom_KernSJV_2020_Annual_trips_20171222143741.csv” for the 
tips file; 

• “Custom_KernSJV_2020_Annual_vmt_20171222143741.csv” for the 
vehicle miles traveled file; 

• “Custom_KernSJV_2020_Annual_planning_20171222143742.xlsx” for 
the planning inventory file; 
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• “Custom_KernSJV_2020_Annual_ctf_20171222143742.csv” for the 
CEIDARS Transaction Format (CTF) file. 

 
The default names for the output files for the run specification file for the 
emission rates input file “PL_AlamedaSF_2012_Annual.ers” will be: 

• “PL_AlamedaSF_2012_Annual_20171230115638.csv” for the emissions 
rate file 

7.1 CSV  (COMMA-SEPARATED VALUES)  
The standard output format from EMFAC2017 is CSV (comma-separated values), 
which is not to be confused with the CSV report from the previous versions of 
EMFAC. CSV is a common, relatively simple file format that is widely supported 
by consumer, business, and scientific applications. 

 
For emissions runs, both EMFAC default and custom activity type, the model may 
output up to four CSV files per Sub-Area and Calendar Year. Typically emissions 
data, VMT, trips, and vehicle population data are reported in separate output 
files. 

 
Please note that the speed_time column in the emissions rates report from a PL 
run contains different values for different processes. It indicates speed bin for 
running exhaust and it indicates the time, in minutes, that the vehicle has been 
sitting prior to starting for start emissions. 

 
Table 7-1 provides descriptions of the columns in the emissions, activity, and 
emission rates CSV output files. Table 7-2 lists the emissions processes in the 
emissions rates output files. 
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Table 7-1. Summary of Columns in CSV output Files 
 

Column Name Description 
calendar_year Calendar Year between 2000 -2050 
season_month Annual, summer, winter or one of the twelve months 
sub_area (GAI) Sub Area as defined in Appendix 3 
vehicle_class Vehicle class as defined in Appendix 4 
fuel Gasoline, diesel, or other fuel types 
model_year Model year 
hour One of the 24 hour 
speed Speed bin from 5 to 90 with 5 incremental 
process Emission process 
cat_ncat With or without catalytic converter 
pollutant Pollutants 
emission Amount of emissions 
vmt Vehicle-miles traveled 
trips Number of trips 
population Vehicle population 
temperature Temperature in Fahrenheit 
relative_humidity Relative humidity in percentage 

 
 
 

speed_time 

 
For running exhaust (RUNEX), the “speed_time” column provides 
the speed bin ranging from 5 mph to 90 mph. For the start 
process, this field provides the soak time prior to vehicle starting 
in minutes, ranging from 5 minutes to 720 minutes. For other 
processes, where emissions rates do not depend on speed bin or 
soak time, this field is blank. 

emission_rate Emissions per unit of activity 
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Table 7-2. Emissions Processes in Emissions Rates Files 
 

Emission Process Description 

RUNEX Running Exhaust 

IDLEX Idle Exhaust 

STREX Start Exhaust 

RUNLOSS Running Loss 

PRESTLOSS Partial Day Resting Loss 

MDRESTLOSS Multi-Day Resting Loss 

RESTLOSS Resting Loss 

PDIURN Partial Day Diurnal Loss 

MDDIURN Multi-Day Diurnal Loss 

DIURN Diurnal Loss 

PMTW PM Tirewear 

PMBW PM Brakewear 

 
As stated in Section 4.1, in order to manage the size of the output files, emissions 
and emission rates equal to zero are not indicated in the output files. Therefore, 
in instances when data are missing in the output file, the user can assume zero 
emissions or an emission rate of zero. 



EMFAC2017 User’s Guide, v1.0.2 

67 

 

 

7.2 PLANNING  INVENTORY REPORT  
The Planning Inventory Report generated from the Custom Activity type is a 
Microsoft Excel Workbook that contains emissions and activities which are 
summed by area, calendar year, and vehicle-tech type. It provides a column for 
every pollutant and process, with sub-total columns at the appropriate places. It 
provides a summary worksheet for a given area and another worksheet entitled 
“By Sub-Area” in which the data are broken out by the sub-areas within the area 
specified by the user(if selected). If a run is only for a single sub-area, or if an area 
only has one sub-area (such as the Lake County Air Basin), only one data 
worksheet will be produced. This report includes a “Read_me” tab and a 
“Glossary tab” which provides information on the report type, the date and time 
the report was generated, and an explanation of the columns. 

 
 

IMPORTANT! The Planning Inventory Report generated from the Custom Activity 
type does not correspond to official GHG emissions. However, the EMFAC2017 
default runs employ a methodology consistent with CARB’s official GHG inventory 
estimation. 
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7.3 SB375 REPORT  
The SB375 report generated from the Custom Activity type is a Microsoft Excel 
Workbook that is a sub-set of the Planning Inventory Report described above. It 
is limited to four vehicle types, CO2 emissions, and the related activity. The only 
vehicle-tech types included in this SB375 report are: 

• LDA - DSL 
• LDA - GAS 
• LDT1 - DSL 
• LDT1 - GAS 
• LDT2 - DSL 
• LDT2 - GAS 
• MDV - DSL 
• MDV – GAS 

 
 

IMPORTANT! – Note again that, for SB375 analyses, the Advanced Clean Cars 
(ACC)/Pavley are deactivated. Also, because the ACC regulation has certain 
assumptions about vehicle usage built into it, default data in custom activity 
templates produced for conformity assessments will not match the default data in 
templates for SB375 assessments (differences will result and affect any 
comparisons between the two). As a result, CO2 emissions in an SB375 report will 
not equal CO2 emissions from a standard planning inventory report. 
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7.4 CTF REPORT  
The CEIDARS Transaction Format (CTF) generated from the Custom Activity type is 
a report used internally by the CARB to import emissions inventory data into an 
internal emissions inventory database and forecasting system. The area and sub- 
area fields, produced by EMFAC, are replaced with the County-Air Basin-District 
coding system, and the Emissions Inventory Code (EIC) system replaces the 
vehicle-tech type and the processes. Appendix 8 provides a description of the 
fields in a CTF file. 
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APPENDIX 1  DISK SPACE REQUIREMENTS FOR RUNNING EMFAC2017  
The disk space needed to perform EMFAC2017 runs consists of two parts: the disk space needed to run the 
model, i.e. to perform database operations (on system drive); and the disk space needed on the user 
specified drive for saving output files. Both vary significantly based on the specifications of the run. If the 
output drive is the same as the system drive, the two parts will need to be added up. This appendix 
provides estimates for some typical runs that can be used to help estimate the space needed for a 
particular run. 

• Default Runs 
1. The disk space needed for database operations for default runs can be up to about 3 GB if “By 

Speed” is selected; 
2. If speed is not selected it usually should not take more than 1 GB; 
3. The disk space estimates for the output files for ONE sub-area, ONE calendar year, ALL vehicle 

classes, ALL pollutants, ALL activities (size may vary slightly by sub-area and calendar year): 
 

Vehicle Class 
Type 

By Hour By Speed By Model 
Year 

By Fuel By Process Output 
Size 

2011 No No No No No 0.05 MB 
2011 No No No Yes Yes 0.2 MB 
2011 Yes No No Yes Yes 4 MB 
2011 Yes Yes No Yes Yes 25 MB 
2011 Yes Yes Yes (All) Yes Yes 1 G 
2007 Yes Yes Yes (All) Yes Yes 500 MB 
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• SG Runs: 
1. The disk space needed for database operations for SG runs can be up to about 3GB if 

“Hourly_Fraction_Veh_Tech_Speed” is included in the template; 
2. If “Hourly_Fraction_Veh_Tech_Speed” is not included, it should not take more than 1GB; 
3. The disk space estimates for ONE sub-area and ONE calendar year for EMFAC2017 input 

templates: 
 

 
SG Run with 
EMFAC2017Custom Activity File 

 
Custom 
Speed 
Fraction 

 
CSV 
Template 
Size 

 
CSV Output Size 

 
Planning Inventory 
Output Size 

 
CTF Output Size 

 
SB375 Output Size 

Total daily VMT Yes 0.18MB 25MB 
 
 
 
 
 
 

0.04 M 

 
 
 
 
 
 

0.3 M 

 
 
 
 
 
 

0.009MB 

No 0.007MB 0.16MB 

VMT by vehicle and 
fuel type 

Yes 0.18MB 20MB 

No 0.008MB 0.12MB 
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Tab Run Parameters Description 

 
Area 

Area Type One of the area types can be picked. 

Area One or more areas can be selected for one run. 
 
 

Time 

Calendar Year Between 2000 and 2050. One or more calendar years can be selected for one run. 

Season/Month One of the three seasons (annual, summer, winter) or one of the 12 months can be selected for one run. 

Day or Hour Aggregation Output emissions by day or by hour. 
 
 

 
Vehicles 

Vehicle Class type Output by EMFAC2011 vehicle class or EMFAC2007 vehicle class. 

Vehicle Class One or more vehicle classes can be picked for one run. 

Model Year Aggregated or by model year in output. One or more model years can be selected if by model year is picked. 

Speed Aggregated or by speed in output. 

Output Natural Gas Heavy Duty Vehicles Whether output by Natural Gas for Heavy Duty Vehicles 
 
 
 

 
Output 

Pollutants Pollutants in output. 

Activities Pick one or more of the activities (VMT, vehicle population, or trips) to be included in output files. 

Output by process Whether output by process. 

Output by Cat/NonCat Whether output by Cat/NonCat. 

Save data for future use Users can get results faster in the future if data from previous runs are saved and used. 

Output Options Split output by Sub Area& Calendar Year 
Where to save output files. 

APPENDIX 2 SUMMARY OF RUN PARAMETERS FOR GENERATING DEFAULT 
EMISSIONS INVENTORY 
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Sub-Area County Name Air Basin Name Air District Name MPO MPO Name 

Alameda (SF) ALAMEDA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Alpine (GBV) ALPINE GREAT BASIN VALLEYS GREAT BASIN UNIFIED APCD   

Amador (MC) AMADOR MOUNTAIN COUNTIES AMADOR COUNTY APCD   

Butte (SV) BUTTE SACRAMENTO VALLEY BUTTE COUNTY AQMD BCAG Butte County Association of Governments 

Calaveras (MC) CALAVERAS MOUNTAIN COUNTIES CALAVERAS COUNTY APCD 
  

Colusa (SV) COLUSA SACRAMENTO VALLEY COLUSA COUNTY APCD 
  

Contra Costa (SF) CONTRA COSTA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Del Norte (NC) DEL NORTE NORTH COAST NORTH COAST UNIFIED AQMD   

El Dorado (LT) EL DORADO LAKE TAHOE EL DORADO COUNTY APCD TMPO Tahoe Metropolitan Planning Organization 

El Dorado (MC) EL DORADO MOUNTAIN COUNTIES EL DORADO COUNTY APCD SACOG Sacramento Area Council of Governments 

Fresno (SJV) FRESNO SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD COFCG Fresno Council of Governments 

Glenn (SV) GLENN SACRAMENTO VALLEY GLENN COUNTY APCD   

Humboldt (NC) HUMBOLDT NORTH COAST NORTH COAST UNIFIED AQMD   

Imperial (SS) IMPERIAL SALTON SEA IMPERIAL COUNTY APCD SCAG Southern California Association of Governments 

Inyo (GBV) INYO GREAT BASIN VALLEYS GREAT BASIN UNIFIED APCD   

Kern (MD) KERN MOJAVE DESERT KERN COUNTY APCD KCOG Kern Council of Governments 

Kern (SJV) KERN SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD KCOG Kern Council of Governments 

Kings (SJV) KINGS SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD KCAG Kings County Association of Governments 

Lake (LC) LAKE LAKE COUNTY LAKE COUNTY AQMD   

Lassen (NEP) LASSEN NORTHEAST PLATEAU LASSEN COUNTY APCD   

Los Angeles (MD) LOS ANGELES MOJAVE DESERT ANTELOPE VALLEY AQMD SCAG Southern California Association of Governments 

Los Angeles (SC) LOS ANGELES SOUTH COAST SOUTH COAST AQMD SCAG Southern California Association of Governments 

Madera (SJV) MADERA SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD MCTC Madera County Transportation Commission 

Marin (SF) MARIN SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Mariposa (MC) MARIPOSA MOUNTAIN COUNTIES MARIPOSA COUNTY APCD   

Mendocino (NC) MENDOCINO NORTH COAST MENDOCINO COUNTY AQMD   

Merced (SJV) MERCED SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD MCAG Merced County Association of Governments 

APPENDIX 3 DEFINITION OF AREAS 
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Sub-Area County Name Air Basin Name Air District Name MPO MPO Name 

Modoc (NEP) MODOC NORTHEAST PLATEAU MODOC COUNTY APCD   

Mono (GBV) MONO GREAT BASIN VALLEYS GREAT BASIN UNIFIED APCD   

Monterey (NCC) MONTEREY NORTH CENTRAL COAST MONTEREY BAY UNIFIED APCD AMBAG Association of Monterey Bay Governments 

Napa (SF) NAPA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Nevada (MC) NEVADA MOUNTAIN COUNTIES NORTHERN SIERRA AQMD   

Orange (SC) ORANGE SOUTH COAST SOUTH COAST AQMD SCAG Southern California Association of Governments 

Placer (LT) PLACER LAKE TAHOE PLACER COUNTY APCD TMPO Tahoe Metropolitan Planning Organization 

Placer (MC) PLACER MOUNTAIN COUNTIES PLACER COUNTY APCD SACOG Sacramento Area Council of Governments 

Placer (SV) PLACER SACRAMENTO VALLEY PLACER COUNTY APCD SACOG Sacramento Area Council of Governments 

Plumas (MC) PLUMAS MOUNTAIN COUNTIES NORTHERN SIERRA AQMD   

Riverside (MD/MDAQMD) RIVERSIDE MOJAVE DESERT MOJAVE DESERT AQMD SCAG Southern California Association of Governments 

Riverside (MD/SCAQMD) RIVERSIDE MOJAVE DESERT SOUTH COAST AQMD SCAG Southern California Association of Governments 

Riverside (SC) RIVERSIDE SOUTH COAST SOUTH COAST AQMD SCAG Southern California Association of Governments 

Riverside (SS) RIVERSIDE SALTON SEA SOUTH COAST AQMD SCAG Southern California Association of Governments 

Sacramento (SV) SACRAMENTO SACRAMENTO VALLEY SACRAMENTO METROPOLITAN AQMD SACOG Sacramento Area Council of Governments 

San Benito (NCC) SAN BENITO NORTH CENTRAL COAST MONTEREY BAY UNIFIED APCD AMBAG Association of Monterey Bay Governments 

San Bernardino (MD) SAN BERNARDINO MOJAVE DESERT MOJAVE DESERT AQMD SCAG Southern California Association of Governments 

San Bernardino (SC) SAN BERNARDINO SOUTH COAST SOUTH COAST AQMD SCAG Southern California Association of Governments 

San Diego (SD) SAN DIEGO SAN DIEGO SAN DIEGO COUNTY APCD SANDAG San Diego Association of Governments 

San Francisco (SF) SAN FRANCISCO SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

San Joaquin (SJV) SAN JOAQUIN SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD SJCOG San Joaquin Council of Governments 

San Luis Obispo (SCC) SAN LUIS OBISPO SOUTH CENTRAL COAST SAN LUIS OBISPO COUNTY APCD SLOCOG San Luis Obispo Council of Governments 

San Mateo (SF) SAN MATEO SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Santa Barbara (SCC) SANTA BARBARA SOUTH CENTRAL COAST SANTA BARBARA COUNTY APCD SBCAG Santa Barbara County Association of Governments 

Santa Clara (SF) SANTA CLARA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Santa Cruz (NCC) SANTA CRUZ NORTH CENTRAL COAST MONTEREY BAY UNIFIED APCD AMBAG Association of Monterey Bay Governments 

Shasta (SV) SHASTA SACRAMENTO VALLEY SHASTA COUNTY AQMD SCRTPA Shasta Regional Transportation Agency 

Sierra (MC) SIERRA MOUNTAIN COUNTIES NORTHERN SIERRA AQMD   

Siskiyou (NEP) SISKIYOU NORTHEAST PLATEAU SISKIYOU COUNTY APCD   
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Sub-Area County Name Air Basin Name Air District Name MPO MPO Name 

Solano (SF) SOLANO SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Solano (SV) SOLANO SACRAMENTO VALLEY YOLO/SOLANO AQMD MTC Metropolitan Transportation Commission 

Sonoma (NC) SONOMA NORTH COAST NORTHERN SONOMA COUNTY APCD MTC Metropolitan Transportation Commission 

Sonoma (SF) SONOMA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Stanislaus (SJV) STANISLAUS SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD StanCOG Stanislaus Council of Governments 

Sutter (SV) SUTTER SACRAMENTO VALLEY FEATHER RIVER AQMD SACOG Sacramento Area Council of Governments 

Tehama (SV) TEHAMA SACRAMENTO VALLEY TEHAMA COUNTY APCD   

Trinity (NC) TRINITY NORTH COAST NORTH COAST UNIFIED AQMD   

Tulare (SJV) TULARE SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD TCAG Tulare County Association of Governments 

Tuolumne (MC) TUOLUMNE MOUNTAIN COUNTIES TUOLUMNE COUNTY APCD   

Ventura (SCC) VENTURA SOUTH CENTRAL COAST VENTURA COUNTY APCD SCAG Southern California Association of Governments 

Yolo (SV) YOLO SACRAMENTO VALLEY YOLO/SOLANO AQMD SACOG Sacramento Area Council of Governments 

Yuba (SV) YUBA SACRAMENTO VALLEY FEATHER RIVER AQMD SACOG Sacramento Area Council of Governments 
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EMFAC2011 Veh & Tech 

 
 
 

EMFAC2011 
Vehicle 

 
 
 

Description 

 
 
 

EMFAC2007 
Vehicle 

 
 

EMFAC2007 
Vehicle 

Code 

 
 
 

Truck / Non- 
Truck Category 

 
 

Truck 1 / 
Truck 2 / 

Non-Truck 
Category 

LDA - DSL  
LDA 

 
Passenger Cars 

 
LDA 

 
PC 

Non-Trucks Non-Trucks 
LDA - GAS 

Non-Trucks Non-Trucks LDA - Elec 
LDT1 - DSL  

LDT1 

 
Light-Duty Trucks ( GVWR < 6000 lbs and ETW <= 

3750 lbs) 

 
LDT1 

 
T1 

Non-Trucks Non-Trucks 
LDT1 - GAS 

Non-Trucks Non-Trucks LDT1 - Elec 
LDT2 - DSL  

LDT2 

 
Light-Duty Trucks (GVWR < 6000 lbs and ETW 3751- 

5750 lbs) 

 
LDT2 

 
T2 

Non-Trucks Non-Trucks 
LDT2 - GAS 

Non-Trucks Non-Trucks LDT2 - Elec 
LHD1 - DSL  

LHD1 
 

Light-Heavy-Duty Trucks (GVWR 8501-10000 lbs) 
 

LHDT1 
 

T4 
Trucks Truck 1 

LHD1 - GAS Trucks Truck 1 

LHD2 - DSL  
LHD2 

 
Light-Heavy-Duty Trucks (GVWR 10001-14000 lbs) 

 
LHDT2 

 
T5 

Trucks Truck 1 

LHD2 - GAS Trucks Truck 1 

MCY - GAS MCY Motorcycles MCY MC Non-Trucks Non-Trucks 

MDV - DSL  
MDV 

 
Medium-Duty Trucks (GVWR 6000 and 8500 lbs ) 

 
MDV 

 
T3 

Non-Trucks Non-Trucks 
MDV - GAS 

Non-Trucks Non-Trucks 
MDV - Elec 
MH - DSL  

MH 
 

Motor Homes 
 

MH 
 

MH 
Non-Trucks Non-Trucks 

MH - GAS Non-Trucks Non-Trucks 

T6 Ag - DSL T6 Ag Medium-Heavy Duty Diesel Agriculture Truck that are 
using Ag truck exemptions of the T&B rule 

 
 
 
 
 

MHDT 

 
 
 
 
 

T6 

Trucks Truck 2 

T6 CAIRP heavy - DSL T6 CAIRP heavy Medium-Heavy Duty Diesel CA International 
Registration Plan Truck with GVWR>26000 lbs Trucks Truck 2 

T6 CAIRP small - DSL T6 CAIRP small Medium-Heavy Duty Diesel CA International 
Registration Plan Truck with GVWR<=26000 lbs Trucks Truck 2 

T6 instate construction heavy - 
DSL 

T6 instate 
construction heavy 

Medium-Heavy Duty Diesel instate construction Truck 
with GVWR>26000 lbs Trucks Truck 2 

T6 instate construction small - 
DSL 

T6 instate 
construction small 

Medium-Heavy Duty Diesel instate construction Truck 
with GVWR<=26000 lbs Trucks Truck 2 

T6 instate heavy - DSL T6 instate heavy Medium-Heavy Duty Diesel instate Truck with 
GVWR>26000 lbs Trucks Truck 2 

APPENDIX 4 VEHICLE CATEGORIES 
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T6 instate small - DSL T6 instate small Medium-Heavy Duty Diesel instate Truck with 
GVWR<=26000 lbs 

  
Trucks Truck 2 

T6 OOS heavy - DSL T6 OOS heavy Medium-Heavy Duty Diesel Out-of-state Truck with 
GVWR>26000 lbs Trucks Truck 2 

T6 OOS small - DSL T6 OOS small Medium-Heavy Duty Diesel Out-of-state Truck with 
GVWR<=26000 lbs Trucks Truck 2 

T6 Public - DSL T6 Public Medium-Heavy Duty Diesel Public Fleet Truck Trucks Truck 2 

T6 utility - DSL T6 utility Medium-Heavy Duty Diesel Utility Fleet Truck Trucks Truck 2 

T6TS - GAS T6TS Medium-Heavy Duty Gasoline Truck Trucks Truck 2 

T7 Ag - DSL T7 Ag Heavy-Heavy Duty Diesel Agriculture Truck that are 
using Ag truck exemptions of the T&B rule 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
HHDT 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
T7 

Trucks Truck 2 

T7 CAIRP - DSL T7 CAIRP Heavy-Heavy Duty Diesel CA International 
Registration Plan Truck Trucks Truck 2 

T7 CAIRP construction - DSL T7 CAIRP 
construction 

Heavy-Heavy Duty Diesel CA International 
Registration Plan Construction Truck Trucks Truck 2 

T7 NNOOS - DSL T7 NNOOS Heavy-Heavy Duty Diesel Non-Neighboring Out-of- 
state Truck Trucks Truck 2 

T7 NOOS - DSL T7 NOOS Heavy-Heavy Duty Diesel Neighboring Out-of-state 
Truck Trucks Truck 2 

T7 other port - DSL T7 other port Heavy-Heavy Duty Diesel Drayage Truck at Other 
Facilities Trucks Truck 2 

T7 POAK - DSL T7 POAK Heavy-Heavy Duty Diesel Drayage Truck in Bay Area Trucks Truck 2 

T7 POLA - DSL T7 POLA Heavy-Heavy Duty Diesel Drayage Truck near South 
Coast Trucks Truck 2 

T7 Public - DSL T7 Public Heavy-Heavy Duty Diesel Public Fleet Truck Trucks Truck 2 

T7 Single - DSL T7 Single Heavy-Heavy Duty Diesel Single Unit Truck Trucks Truck 2 

T7 single construction - DSL T7 single 
construction 

Heavy-Heavy Duty Diesel Single Unit Construction 
Truck Trucks Truck 2 

T7 SWCV - DSL 
T7 SWCV Heavy-Heavy Duty Diesel Solid Waste Collection Truck Trucks Truck 2 

T7 SWCV - NG 

T7 tractor - DSL T7 tractor Heavy-Heavy Duty Diesel Tractor Truck Trucks Truck 2 

T7 tractor construction - DSL T7 tractor 
construction Heavy-Heavy Duty Diesel Tractor Construction Truck Trucks Truck 2 

T7 utility - DSL T7 utility Heavy-Heavy Duty Diesel Utility Fleet Truck Trucks Truck 2 

T7IS - GAS T7IS Heavy-Heavy Duty Gasoline Truck Trucks Truck 2 

PTO - DSL PTO Power Take Off Trucks Truck 2 

SBUS - DSL  
SBUS 

 
School Buses 

 
SBUS 

 
SB 

Non-Trucks Non-Trucks 

SBUS - GAS Non-Trucks Non-Trucks 

UBUS - DSL 
UBUS Urban Buses UBUS UB 

Non-Trucks Non-Trucks 
UBUS - GAS Non-Trucks Non-Trucks 
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UBUS - NG       

Motor Coach - DSL Motor Coach Motor Coach  

OBUS 

 

OB 

Non-Trucks Non-Trucks 

OBUS - GAS OBUS Other Buses Non-Trucks Non-Trucks 

All Other Buses - DSL All Other Buses All Other Buses Non-Trucks Non-Trucks 

 
* GVWR: gross vehicle weight rating 
* ETW: equivalent test weight 
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APPENDIX 5 SUMMARY OF RUN PARAMETERS FOR GENERATING CUSTOM 
ACTIVITY TEMPLATE 

Tab Run Parameters Description  

 
Area 

Area Type One of the area types can be picked. 

Area One or more areas can be selected for one run. 
 

Time 
Calendar Year Between 2000 and 2050. One or more calendar years can be selected for one run. 

Season/Month One of the three seasons (annual, summer, winter) or one of the 12 months can be selected for one run. 
 
 

VMT 

VMT Type Whether input VMT is by daily total or by vehicle and fuel type. 

Hourly Speed Fractions Whether to include custom hourly speed fractions. 

SB375 Whether it is a SB375 template. 

 
 
 
APPENDIX 6 SUMMARY OF RUN PARAMETERS FOR GENERATING CUSTOM 
ACTIVITY EMISSIONS INVENTORY 

Tab Run Parameters Description  

 
Load 

Template File Type Whether it is EMFAC2017 format or EMFAC2011 Format. 

SB375 Whether it is a SB375 run if EMFAC2011 Format is chosen. 
 Custom Activity File The custom activity file in EMFAC2017 or EMFAC2011 format. 
 
 

Output 

Report Type One or more of the reports (csv, planning inventory, or CTF) can be generated for a non-SB375 run. 

Report Type (SB375) Only SB375 report will be generated. 

Save data for future use Users can get results faster in the future if data from previous runs are saved and used. 

Output Directory Where to save output files. 
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Tab Run Parameters Description 

 
Area 

Area Type One of the area types can be picked. 

Area One or more areas can be selected for one run. 
 

Time 
Calendar Year Between 2000 and 2050. One or more calendar years can be selected for one run. 

Season/Month One of the three seasons (annual, summer, winter) or one of the 12 months can be selected for one run. 
 
 

 
Vehicles 

Vehicle Class type Output by EMFAC2011 vehicle class or EMFAC2007 vehicle class or Truck/non-Truck or Truck1/Truck2/non-Truck. 

Vehicle Class One or more vehicle classes can be picked for one run. 

Model Year Aggregated or by model year in output. One or more model years can be selected if by model year is picked. 

Fuel Aggregated or by fuel in output. 

Speed One or more speeds can be selected. 
 

Meteorology 
Temperature Temperature in Fahrenheit. 

Relative Humidity Relative humidity. 
 

Output 
Pollutants Pollutants in output. 

Output Directory Where to save output files. 

APPENDIX 7 SUMMARY OF RUN PARAMETERS FOR GENERATING EMISSION 
RATES 
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APPENDIX 8 FIELDS IN CTF FILE 

FIELD NAME FIELD TYPE LENGTH FIELD DESCRIPTION 
YEAR NUMERIC 4 CAL YEAR OF THE RUN DATA 
DIS CHAR 3 DISTRICT ID 
AB CHAR 3 AIR BASIN ID 
CO NUMERIC 2 COUNTY ID 
EIC NUMERIC 14 EIC CODE 
PR NUMERIC (11,2) 11 ANNUAL PROCESS RATE 
HPDY NUMERIC 2 HOURS PER DAY 
DPWK NUMERIC 2 DAY PER WEEK 
JANT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR JANUARY - RANGE 0-100 
FEBT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR FEBRUARY - RANGE 0-100 
MART NUMERIC(4,1) 5 PERCENT ACTIVITY FOR MARCH - RANGE 0-100 
APRT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR APRIL - RANGE 0-100 
MAYT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR MAY - RANGE 0-100 
JUNT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR JUNE - RANGE 0-100 
JULT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR JULY - RANGE 0-100 
AUGT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR AUGUST - RANGE 0-100 
SEPT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR SEPTEMBER - RANGE 0-100 
OCTT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR OCTOBER - RANGE 0-100 
NOVT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR NOVEMBER - RANGE 0-100 
DECT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR DECEMBER - RANGE 0-100 
POL NUMERIC 9 POLLUTANT CODE 
EMFACT NUMBER (10,4) 11 EMISSION FACTOR (LBS PER EIC UNIT) 
SEASON CHAR 14 SEASON 
EMS NUMERIC(10,4) 11 EMISSIONS (TONS/DAY) 
VERSION CHAR 15 EMFAC VERSION 
OPERATOR CHAR 3 OPERATOR INITIALS 
TDATE DATE 8 TRANSACTION DATE 
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